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TI LaunchPad™ Ecosystem: 
Modular and affordable  
microcontroller development  
tools for rapid prototyping 
Electronics rapid prototyping with TI’s broad portfolio of 

MCUs, analog & connectivity solutions 

 

Internet of Things Workshop  
Texas Instruments                  Wi-Fi & BLE & 

January 2018                           Sub-1GHz 

 



For the greatest crash course on IoT 

and electronics you’ve ever done? 



Wi-Fi Workshop Materials 

• MSP432 LaunchPad (MSP-EXP432P401R) 

– Alternative: MSP-EXP430FR5994, MSP-EXP430F5529LP, EK-TM4C123GXL 

• CC3100 Wi-Fi BoosterPack (CC3100BOOST, CC3100MODBOOST) 

• Educational BoosterPack MK II (BOOSTXL-EDUMKII) 
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MSP432P401R LaunchPad 
Introducing the SimpleLink MSP432 processor for Low Power + Performance 

Target MCU: MSP432P401R 

BoosterPack Pinout: 40-pin 

Specs: 

• 48 MHz 32-bit ARM® Cortex™-M4F CPU 

• 256 kB Flash / 64 kB RAM  

• 14-bit 1MSPS SAR ADC, Timers,  

AES Accelerator, I2C, UART, SPI 

 

EnergyTrace+ to measure system current 

Good performance balance & great for 

general purpose applications 

Why this LaunchPad? 

$12.99 

MSP-EXP432P401R 
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TI SimpleLink™ MCU Platform 
We’re building a cohesive developer ecosystem around our ARM®-based SimpleLink microcontrollers (MCUs) and 

Network Processors, revolving around a single SDK & powerful tool suite enabled by TI & partners. 

Scalable Ultra-Low 

Power MCU Portfolio 

of ARM-based MCUs & 

Network Processors. 

ONE SDK 

Enabling 100% code 

re-use & portability. 

Everything you need is one click away with TI Resource Explorer 

All of your development resources in one place. 

High precision analog 

integration 

Best-in-class 14-bit 

1Msps ADC w/ultra-low-

power consumption 

LaunchPad™ Kits 

Low cost, modular 

hardware dev kits. 

Comprehensive Tool Suite 

TI & 3rd party IDEs, utilities & 

code generation tools 

Wireless solutions 

Wireless SoCs, Stacks & 

certified solutions 

available 14



Unified experience to speed up customer time 

to market and manage IoT product life cycle 
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• Multiple toolchain options to 

match your development needs 

– TI CCS, CCS Cloud, Energia 

– Local & Cloud-based access 

– Add’l toolchains supported: 

IAR, KEIL, GCC 

 

Configure Build Debug 

PinMux EnergyTrace 

UniFlash 

GCC 

Software 

Tools 

Code Composer 

Studio™ IDE 
Energia IDE CCS Cloud IDE 

TI SimpleLink™ SDK Software Tools 

Industry-leading tool suite 

for advanced optimization 

Quickest path to 

developing a real 

application 

Brings Arduino (Wiring) 

APIs to TI SimpleLink 

MCUs 

Tool Chain Support 

3 
Immerse yourself 

in SimpleLink 

ecosystem 

Import into 

CCS Cloud 

IDE 

Edit, Build, 

Debug & 

Flash 

2 1 

Get things done with  

TI Cloud Tools 
from your web browser 



Wi-Fi Workshop Pre-work 
We will break here and get started with the hardware! 

1. Download Energia from www.energia.nu 

2. Unzip Energia to “install” it 

3. Start Energia and select your LaunchPad “LaunchPad w/ msp432 EMT (48MHz)” 

from Tools menu. 

 

 

4. If LaunchPad isn’t available, then go to the board manager  

to install – Tools > Board > Board Manager…  

5. Create your free accounts at: my.ti.com and temboo.com 

Lab- https://goo.gl/VbymuW 

http://www.energia.nu/
my.ti.com
temboo.com


Lab 1 CCS Cloud & MSP432 LaunchPad Out of Box 

1. Open TI Resource Explorer Cloud from dev.ti.com 

2. Find the Out-of-Box Experience (OOBE) for MSP-EXP432P401R – Rev 2.x (Red) 

3. Import OOBE into CCS Cloud 

( You will need to log into  

  my.ti.com to access the IDE ) 

 

 

4. Build the OOBE project (using hammer icon) 

and then click on “Run” to download the program to the LaunchPad (see LED blink) 

5. Click back over to the TI Resource Explorer window and select: 

  Out-of-Box Experience GUI 

6. Connect the GUI to the LaunchPad (“Connect” button) 
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Lab- https://goo.gl/VbymuW 



Lab 2 Energia Introduction with Blink and the EduBP 

We will break here and get started with the hardware! 

• Step 1: Install Energia IDE from www.energia.nu 

– Alternative use the CCS Cloud IDE from dev.ti.com 

• Step 2: Install any OS specific drivers associated with your TI LaunchPad 

• Step 3: Plug in your TI LaunchPad board with the included USB cable 

• Step 4: Open Energia IDE and adjust your preferences as necessary 

• Step 5: Open basic test example - click File > Examples > Basics > Blink 

• Step 6: Select your LaunchPad board or install board package – click Tools > 

Board 

– If LaunchPad is not MSP430 then go to the board manager to install – Tools > 

Board > Board Manager… and install your package from the menu. Select your 

specific LaunchPad from the list after installation.  22 

Lab: 

https://goo.gl/VbymuW 
 

http://www.energia.nu/


• Step 7: Click the upload button and make sure your Red LED is blinking 

– If not or you get errors during compile, your system is not properly setup and 

you will not be able to proceed, so seek assistance from instructor or neighbors 

– If yes, then you can now test the Educational BoosterPack 

• Step 8: Open EDUBP example mentioned in the lab details 

• Step 9: Click the upload button. You can use the joystick and see results on the 

LCD. Test it out! 

• Step 10: There are additional examples for the BoosterPack that you can try if you 

have extra time, however we will be moving on quickly. They are documented at 

www.energia.nu/edumkii 

• Examples are located in the IDE, click File > Examples > EducationalBP_MKII  
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Lab 2 Energia Introduction with Blink and the EduBP 

http://www.energia.nu/edumkii


The Internet of Things 
a history 

Edison & Tesla 
• It pretty much always 

starts with the lightbulb, 

harnessing electricity for 

human applications, took 

lots of famous people to 

get to this point 

The Rise of Electronics 
From large desktop computers to tiny battery powered devices, 

EVERY innovation is all part of the same technology revolution 
 

 

Tubes, Transistors & 

Radio 
• Electric computation and 

communication becomes 

possible and mainstream 

with the creation of the 

basic building blocks 

The Integrated Circuit 
• Jack Kilby, a TI 

engineer, changed the 

world by inventing a 

practical way to shrink 

the size of electronics 

1800s-1900s 1900s-1960s 1958 



The Internet of Things 
a history 

The PC Age 
• Personal computers 

change business and 

productivity in every 

aspect of life worldwide 

The Rise of Electronics 
From large desktop computers to tiny battery powered devices, 

EVERY innovation is all part of the same technology revolution 
 

 

The Internet Age (& Mobile) 

•  Computers and electronics  

 can talk to each other 

 creating a whole new world 

 of applications 

The IoT Age 
• Affordable connectivity 

and processing gives all 

electronics additional 

capabilities for new data 

driven and world 

changing behavior 

1970s-1990s 1990s-2010s 2000s-2030s 



The Internet of Things 
a history 

Government 

This tech wave will have lasting 

effects on EVERY industry 
 

 

Medical 

Agriculture 

Automotive 

Manufacturing 

Transportation Industrial 

Retail / Ecommerce 

Military 

Aviation 

Marine / Aquaculture 

Energy 

Food Real Estate Finance Construction 



 
 
Join the IoT revolution! 
 
See the World! 
 
Build a new industry! 

 Calling all Engineers, Makers, Entrepreneurs 
 

 

 
 

IoT will change your life! 
 

Can you make the next 
Great Product or Service? 

 

http://www.google.com/url?sa=i&rct=j&q=&esrc=s&source=images&cd=&cad=rja&uact=8&ved=0ahUKEwjKsMygh-vOAhUG_WMKHaOMA-YQjRwIBw&url=http://www.prsaneworleans.org/wp/call4volunteers__trashed/uncle-sam-we-want-you/&psig=AFQjCNHVh3tu-LtL-Q8Fs6s-KbLUVxYk0w&ust=1472712326739592


The Internet of Things 
a birds eye view 

Think services 
• Google, Amazon, 

Facebook, etc. 

Think servers 
• Server farms  

& data centers 

IoT Data passes from physical hardware layers to software 

layers back and forth, connecting the real and digital worlds 

Cloud 

Think infrastructure 
• Routers, switches, cell 

towers, fiber optic cable, 

satellite transmitters, 

phone lines 

The 

Internet 

Connected  

Things 

Computers 

Phones 

Think products 
• Anything that can talk to 

the internet or connect 

to something else that 

can talk to the internet 

Edge 

Hardware + 

Software at 

every stage 



The Internet of Things 
a birds eye view 

Think services 
• Google, Amazon, 

Facebook, etc. 

Think servers 
• Server farms  

& data centers 

IoT Data passes from physical hardware layers to software 

layers back and forth, connecting the real and digital worlds 

Cloud 

Think infrastructure 
• Routers, switches, cell 

towers, fiber optic cable, 

satellite transmitters, 

phone lines 

The 

Internet 

Connected  

Things 

Computers 

Phones 

Think products 
• Anything that can talk to 

the internet or connect 

to something else that 

can talk to the internet 

Edge 

Hardware + 

Software at 

every stage 

OT 
 

Operational Technology 

 
Sensors, Actuators, Nodes 

IT  
 

Information Technology 

 
Cloud, Servers, Routers 



Edge Processing or Server Compute? 
a comparison 

Edge Processing (Hot Data Path) 

You are processing heavy bits of data 

on the IoT device before delivery of  

simple packets  

 

Advantages 
• Keeps your data transmission smaller 

(bandwidth constrained radio transmission or 

expensive data rates) 

• Distributed, less prone to security threats 

 

 

Disadvantages 
• More programmed logic on device side 

• Harder to update 

• Possibility of less uptime 

Server Side Processing (Cold Data Path) 

You are simply collecting and transmitting 

raw data or simplified converted data to 

the server for further processing 

 

Advantages 
• Common infrastructure and maintenance 

• Take advantage of nearly unlimited compute 

power or magnitudes higher than an individual 

edge device 

• Easy to update, low downtime 

 

Disadvantages 
• More frequent packets 

• Database / data stream management 

• Server downtime jeopardizes whole system 



TI LaunchPad & IoT   
a bird’s eye view 

MCU +  

Ethernet 

LaunchPad RF 

Booster 

Pack 

MCU + RF  

SoC 

LaunchPad RF 

Booster 

Pack 

IoT Gateways 
Your portal to the cloud 

Ethernet Wi-Fi 

Wireless  

Nodes 
Connecting your 

devices 

MCU 

LaunchPad 

 

 
BoosterPack 

MCU + RF  

SoC  

LaunchPad 

Cloud Service 

Provider 

LaunchPads 

- MSP430  

- MSP432 

- TM4C 

- C2000 

- Hercules 

 

 

RF BoosterPacks 

- Zigbee / Zwave 

- 6LoWPAN / Thread 

- Bluetooth / Wi-Fi 

- SubGHz RF / NFC 

- LTE / Satellite 

MCU + RF SoC LaunchPads 

- CC3220 MCU + Wi-Fi 

- CC3200 MCU + Wi-Fi 

- CC2640R2 MCU + BLE 

- CC2650 MCU + BLE 

- CC1310 MCU + SubGHz RF 

- CC1350 MCU + SubGHz/2.4GHz 

 

Cloud services 

Access to data, 

dashboards, etc 



TI LaunchPad & BeagleBone Embedded System Design 
a bird’s eye view 

MCU 

LaunchPad 

or MPU  

BeagleBone 

Sensor 

Embedded System 
• Power Management 

• Communication 

• Processing 

• Analog 

Design Accessories 
• Plug-in modules 

• Through hole (breadboard) 

circuits 

• Oscilloscope & logic 

analyzer & multimeter 

• EDA / CAD tool (PCB and 

enclosure design) 

• IDEs and SW Dev tools 

Cloud 

RF Radio 

/ Wired 

Comm 

Power 

Motor 

Control 

Input /  

Output 

Display 



Breakthrough Sensor Technology www.ti.com/sensing 



Power: Line Power vs Disposable Battery vs Rechargeable Battery 
a comparison 

Design Considerations 
• Do I need continuous power? 

• How convenient is it to recharge in 

the application? 

• How mobile is the application? 

• What is the form factor? 

• What are the aesthetics and 

usability requirements? 

 
 

 

 

What’s the difference? 
• Alkaline 

• Li-Ion 

• Li-Po or Li-Poly 

• Lead Acid 

• Nickel Metal Hydride 

• Nickel Cadmium 
 

 

Make use of tools like TI WEBENCH 



Motors: Brushless vs Brushed vs Stepper 
a comparison 

Design Considerations 
• Do I need accurate movement? 

(Stepper, encoders, hall effect sensors) 

• Do I need high torque? 

• Low complexity or high complexity 

control? 

• Do I need high efficiency or long life? 

• Do I need low cost? 

 

 
 

 

 

What’s the difference? 
• Brushless 

• Brushed 

• Stepper 

• AC / DC  
 

 

Big portion of IoT is around 

intelligent movement 
 

Make use of motor drivers and 

software libraries like TI MotorWare 



Motors: Brushless vs Brushed vs Stepper 
a comparison 

Advantages 
• Cheapest and simplest motor 

• Speed linear to applied voltage 

• Simple Motor Control 

 

Disadvantages 
• High maintenance 

• Low life-span (due to physical 

wear on brushes) 

Advantages 
• High efficiency, long life 

• Little to no maintenance 

• High output power 

 

Disadvantages 
• More complicated motor 

control 

• More expensive 

Advantages 
• Accurate position control 

• Excellent low speed torque 

• Long life 

 

Disadvantages 
• Low efficiency 

• Prone to noise, ripple, and 

resonance 

• Cannot accelerate loads rapidly 



Design Considerations 
• Do I need color graphics? 

• Does it require high refresh? Video? 

• Do I need to display digits or 

alphanumeric? 

• Does it need to be low power or 

battery free? Backlight? 

• How will it mount in the enclosure? 
 

 

What’s the difference? 
• LCD 

• OLED 

• LED Matrix 

• LED Segment 

• ePaper 

• Cloud GUI, Web App, or Mobile App 
 

 

Displays: LCD vs OLED vs LED vs ePaper 
a comparison 

Make use of display drivers  

and software libraries like  

TI Graphics Libraries 
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Easily add RF for wireless applications! 
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Which wireless? 

• Ubiquitous 

• High bandwidth 

• Higher power 

usage 

• Common 

• Small range 

• Lower power 

• Very low cost 

• Super near 

range 

• Low bandwidth 

• Low power 

• Low cost 

• Mesh networking 

• Low power 

• Very low cost 

• IPV6 Addressable 

• Wide range 

• High bandwidth 

• Expensive – 

Data & HW 

• Limited to 

certain cities 

• Wider range 

• Low bandwidth 

• Higher cost 

• Mesh networking 

• Low power 

• Very low cost 

• Not IP addressable 

• Line of Sight 

• Low power 

• Very low cost 

Infrared 

Tradeoffs between range, bandwidth, cost, power usage, adoption 

Satellite 

• Global range w/ 

Sat available 

• Expensive – 

Data & HW 

(LPWAN) (NFC / RFID) 

Proprietary 

• Licensed and 

unlicensed 

spectrum with 

trade offs 

(Cellular) 
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Which wireless? 

• Direct connect 

• Access a wide 

variety of APIs 

directly 

• Only requires 

domain expertise in 

internet and 

firmware  

• High data rate 

• Poor for mobile and 

rural use cases 

 

• Requires a 

middleman 

gateway 

(Smartphone or 

embedded bridge) 

• Everything is 

custom 

• Need domain 

expertise in 

frontend and 

backend, UX, UI, 

firmware 

 

Tradeoffs between implementation effort 

BLE Primary Use Cases 

• Wearable 

• Phone accessory 

• Streaming music 

• Smart Home 

• Medical 

• Low data rate 

• Poor for crowded 

environment 

 

 

Wi-Fi Primary Use Cases 

• Smart Home 

• Industrial/Commercial 

• Fixed position 

connectivity 

• Medical 



TI LaunchPad and BeagleBone in the cloud 

Cloud-connected TI Hardware is supported by various cloud 

partners & protocols via Wi-Fi, BLE, LTE, or Ethernet. 



SaaS or IaaS or PaaS  
a comparison 

SaaS (Software as a Service) 

Application Software that 

you pay a subscription to 

use instead of buying one 

time 

 

Advantages 
• Flexibility 

• 3rd party support 

 

 

 

 

Disadvantages 
• Have to worry about your own 

backend infrastructure 

PaaS (Platform as a Service) 

Applications and Servers 

you pay a subscription to 

use instead of buying and 

building a data center 

 

Advantages 
• Common infrastructure and 

maintenance 

• Take advantage of nearly 

unlimited compute power Easy 

to update, low downtime 

 

Disadvantages 
• Not as much control over 

backend infrastructure 

• Dependent on 3rd party support 

 

IaaS (Infrastructure as a Service) 

Servers that you pay a 

subscription to use instead 

of buying and building in a 

data center 

 

Advantages 
• Common infrastructure and 

maintenance 

• Take advantage of nearly 

unlimited compute power  

• Easy to update, low downtime 

 

Disadvantages 
• Have to configure everything 

custom 

• Variable costs are hard to keep 

track 

SaaS 

 

Software Subscription 

 

 

MS Office 365 

IaaS 

 

IT / Server Infrastructure 

 

 

Amazon Web Services 

PaaS 

 

IT / Server Infrastructure + 

Software Application support 

 

IBM Watson or MS Azure 



IoT Protocols 
a comparison 

Data to Cloud has a cost! 
Protocol has a lot to do with packet size, security, ease of use, capability, scalability 

Ethernet and Wi-Fi assumed data was “free” but mobile IoT now makes that not true 

 

HTTP (Hypertext Transfer Protocol) 
• Classic protocol that runs the traditional internet, request-response paradigm in client-server model 

• Very heavy protocol with large packets and assuming that consuming large quantities of data is okay 

• Highly reliable and easy to learn 

 

MQTT (Message Queue Telemetry Transport) 
• Bi-directional, Publish-Subscribe model 

• Gaining more popularity for IoT as a lightweight alternative for HTTP 

• Easy to learn but requires a Message Broker to be setup in your network or externally 

 

AMQP (Advanced Message Queue Protocol) 
• Emerging IoT protocol that addresses shortfalls of MQTT such as security and file transfers 

• One to one (P2P) and one to many (Pub-Sub) communication 

 



Software Effort: Custom vs. Packaged 
Build your own or use existing tools? 

 

 

 

 

 

 

 

DIY Advantages 
• Highly customized 

• Easier to maintain & less dependencies 

 

 

DIY Disadvantages 
• Lots of work, dedicated resources 

• wide range of expertise required 

 

 

 

 

 

 

 

Buy Advantages 
• Less development work 

• Outside support 

 

 

Disadvantages 
• Dependencies on the tools or services 

• Tool or service limitations 

 

 

IoT Software needs 

Web application, servers, mobile app, device firmware 

 

Types of existing tools 

Open source, SaaS, PaaS, IaaS 
 



Does it feel responsive? 
Does it feel like magic? 

Active Control 

 Human physically interacts 
with machine or system 
 Buttons 
 Touch screen 
 Wired or wireless 

Controller 
 Has to be responsive 

 Quick reactions to input 
 Graphical indicators 
 Light, sound, or haptic 

indicators 

Passive Control 

 Machine or system automatically 
performs tasks 
 Requires minimal Human input 
 Leverages real world sensors or 

incoming data to make 
decisions 

 Leads to poor user experience if 
interaction model is broken 
 E.g. Automatic door  

doesn’t open 

Human Machine Interaction 

Which philosophy is  
Amazon Echo? Xbox? 
Nest Thermostat? 



Rapid Prototyping or Embedded Design? 
  What is the distinction? 

 

• Prototyping makes use of pre-assembled, low cost hardware and open source 

software solutions to quickly build out product concepts.  

 - Open source SW libraries, Arduino shields, breakout modules, dev kits, 3D printing 

 

• You first prototype to prove your application, test use cases, secure budget, find 

investors, define the market in a quick and dirty form factor where time and cash 

investments are huge limitations.  

 - Your prototype can be made pretty, but that doesn’t make it a product! 

 

• Embedded design will mostly scrap what you did in the prototyping stage to optimize for 

cost, scale, size, quality, manufacturability. Everything will be custom from HW to SW. 

-  Don’t fall in love with your prototype, because it won’t be what you release to market!  
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System Level Thinking 
measure all design factors 

Time has a cost! 
Cannot look at your BOM as the only measure of cost. There is design time and there is 

system level cost that should be accounted for 

 

BOM and Manufacturing Costs and Fees 
• Pure dollar amounts 

 

Design time cost 
• Bottle necks can be created depending on quality of evaluation tools, software experience, board layout 

complexity, testing, availability of reference design, vendor support 

 

System level cost 
• Do the parts work together efficiently as a system? System decisions might impact the customer 

experience (more battery life or reliability or flexibility) 

• Is the supply chain strong? Poor inventory levels can result in huge costs 

 

 



System Level Thinking 
measure all design factors 

Time has a cost! 
Cannot look at your BOM as the only measure of cost. There is design time and there is 

system level cost that should be accounted for 

 

BOM and Manufacturing Costs and Fees 
• Pure dollar amounts 

 

Design time cost 
• Bottle necks can be created depending on quality of evaluation tools, software experience, board layout 

complexity, testing, availability of reference design, vendor support 

 

System level cost 
• Do the parts work together efficiently as a system? System decisions might impact the customer 

experience (more battery life or reliability or flexibility) 

• Is the supply chain strong? Poor inventory levels can result in huge costs 

 

 

A good designer can manage these things during a project 

 

A great designer can anticipate these things before a project  

and plan around them 

 

Look at the design at the subsystem level and system level and 

figure out how to best optimize 



www.ti.com/tidesigns 



Microprocessors: Microcontrollers vs Single Board Computers 
a comparison 

Design Considerations 
• Do I need an operating system? 

• Do I want it to be low cost? 

• Can I program in C or do I need to 

use another language? 

• Do I need real-time capability? 

 
 

 

 

What’s the difference? 
• TI LaunchPad 

• BeagleBone  

• Arduino 

• RasPi 
 

 



Microprocessors: Microcontrollers vs Single Board Computers 
a comparison 

Advantages 
• Overall less complex 

• Overall less cost 

• Overall lower power consumption 

• Real-time capable 

 

 

 

Disadvantages 
• Less flexible software paths 

• Less performance for computation 

intensive applications 

• Only able to run RTOS but not full 

OS options 

 

 
 

 

 

Advantages 
• Overall higher performance 

• Overall more peripheral 

capabilities 

• More flexible software options and 

the ability to run Linux OS 

 

 

Disadvantages 
• More cost and complexity 

• Managing Linux related updates 

• Real-time capabilities often limited 

• Higher power consumption 

 
 

 

Considerations: 
 Power 
 Integration 
 Performance 
 Cost 



Microprocessors: Selecting a Processor 
tips & cautions 

How to pick a processor 
• Don’t always trust the vendor to 

guide you - they have many parts 

they are trying to sell! Define your 

spec and stick to it 

• Look for community, educational 

resources, and training 

• Look for well written 

documentation, clean getting 

started experiences, accessible 

software 

• Look for company support 

(phone or email), distributor 

support, pre-certifications to 

speed time to market 

• Beware of NDAs, complicated 

licenses, poor distribution, high 

obsolete rates 
 

 
 

 
 

 

 



Microprocessors: SoC or SoM or SiP  
a comparison 

SoC (System on Chip) 

Integrated processor 

chip with multiple cores 

and radios 

 

 

Advantages 
• Integrate key parts of a 

complex circuit to save 

space on a PCB circuit 

design 

 

Disadvantages 
• Slightly Expensive  

 

Examples 
• CC3220 Wi-Fi 

• CC2640R2F BLE 

 

SoM (System on Module) 

Highly integrated compute 

module that is added to 

various embedded systems 

 

 

Advantages 
• Easily integrate a very complex 

piece of the PCB design into 

simpler PCB circuit designs  

• Save space and design time 

 

Disadvantages 
• Expensive 

 

Examples 
• BeagleCore 

• CC2650MODA 

 

SiP (System in Package) 

Integrated processor chip 

and circuitry all in one 

 

 

 

Advantages 
• Very easily integrate a complex 

processor into a small space 

• Save manufacturing cost and 

development time on board 

design 

Disadvantages 
• Expensive 

 

Examples 
• Octavo OSD3358 
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} { 
Making MADE simple 

With the TI LaunchPad  

Hardware & Software 
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Why TI LaunchPad™ is better? 

• Price $10-$30 

• HW Debugger 

• TI online resources 

 

• Focus on Prototype to Production 

• Performance and Variety 

• Multiple supported SW paths 



TI LaunchPad™ 

20/40-pin Standardized Pinout 
 Add BoosterPack 
 Jumper to your own hardware 
 BYOB – Build Your Own Boosterpack 

Segmented Display (LCD) 
Available on some LaunchPads 

User LEDs 

Isolation Jumper 
Let’s you isolate Target 



Microcontroller 

Programming an MCU… 
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BoosterPack pinout standard (ti.com/byob) 

http://www.ti.com/ww/en/launchpad/dl/boosterpack-pinout-v3.pdf
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BoosterPack pinout standard (ti.com/byob) 

61 61 

The BoosterPack pinout standard enables: 
- Cross-compatibility between LaunchPads & 

BoosterPacks 

- BoosterPack stackability to create more complex 

solutions 

- The same BoosterPack can work across multiple 

LaunchPads 

 

- Learn more @ www.ti.com/byob  

- Build your own BoosterPack (BYOB) with 

templates, resources & more! 

http://www.ti.com/ww/en/launchpad/dl/boosterpack-pinout-v3.pdf
http://www.ti.com/byob


Quick demo recipes 
Enable customers to experience TI differentiation 

WiFi 

CC3100 

BoosterPack 

Thermocouple 

BoosterPack 

(ADS1118) 

WiFi-enabled Meat Probe 

“iGrill”. Send a tweet when 

temp exceeds threshold. 

MSP430F5529 

LaunchPad 

= + + 

NFC/RFID 

(TRF7970A) 

LiPo Battery 

BoosterPack 

(BQ fuel gauge) Create a battery-powered 

WiFi-connected NFC/RFID 

tag reader 

CC3200 Wi-Fi 

LaunchPad 

= + + 

Sub-1GHz 

(CC110L) 

MEMS Temp Sense 

BoosterPack 

(TMP006) Create a multi-point SubGHz 

RF wireless temperature 

sensor network 

MSP430G2553 

LaunchPad 

= + + 

TI Microcontroller TI Wireless TI Analog 
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} { 
Making MADE simple 

With the BeagleBone 

Hardware & Software 
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Why Beaglebone Black is great? 
• Price ~$45 

• Large community 

• Online resources from 

TI and Beagleboard.org 

 

• Full Linux capable single board computer 

• Multiple supported SW paths 

• Completely open source for building your 

own derivative products! 

With BeagleBone Black and Capes 

http://www.google.com/url?sa=i&rct=j&q=&esrc=s&source=images&cd=&cad=rja&uact=8&ved=0ahUKEwjFreTboNjRAhXHNiYKHfroAvgQjRwIBw&url=http://rlx.sk/en/175-beagleboard-beaglebone&bvm=bv.144686652,d.eWE&psig=AFQjCNG1nCeCUXjAZXsO48ajzi3EThK8VQ&ust=1485260509732970
http://www.google.com/url?sa=i&rct=j&q=&esrc=s&source=images&cd=&cad=rja&uact=8&ved=0ahUKEwiNo-KWodjRAhVJOSYKHapYCoUQjRwIBw&url=http://beagleboard.org/Green&bvm=bv.144686652,d.eWE&psig=AFQjCNGGQhfW9Xcb_rjGcqHrnEHQMB_I5Q&ust=1485260611574554


BeagleBone Black 

BeagleBone Black 

Processor: AM335x 1GHz ARM® Cortex-A8 
• 512MB DDR3 RAM 
• 4GB 8-bit eMMC on-board flash storage 
• 3D graphics accelerator 
• NEON floating-point accelerator 
• 2x PRU 32-bit microcontrollers 

 
Connectivity 
• USB client for power & communications 
• USB host 
• Ethernet 
• HDMI 
• 2x 46 pin headers … Add a ‘Cape’ 

 
Software Compatibility 
• Debian 
• Android 
• Ubuntu 
• Cloud9 IDE on Node.js w/ BoneScript lib 
• plus much more 

http://www.ti.com/product/am3358
http://www.ti.com/product/am3358
http://www.ti.com/product/am3358
http://www.ti.com/product/am3358


AM3358 Microprocessor 



BeagleBone Capes  

Pin access to 

external circuits or 

stackable modular 

hardware capes 

through dual 46 pin 

headers 

http://www.google.com/url?sa=i&rct=j&q=&esrc=s&source=images&cd=&cad=rja&uact=8&ved=0ahUKEwjZvdmsntjRAhXDPiYKHcKgADwQjRwIBw&url=http://beagleboard.org/support/bone101&psig=AFQjCNGQ5ZWRNW9wnxV2h5-3gypF1fa0Ig&ust=1485259638961288


 
BeagleBone Blue  
for Robotics 

BeagleBone Blue 

Processor: OSD335x 1GHz ARM® Cortex-A8 
• 512MB DDR3 RAM 
• 4GB 8-bit eMMC on-board flash storage 
• 3D graphics accelerator 
• NEON floating-point accelerator 
• 2x PRU 32-bit microcontrollers 
Connectivity 
• Battery: 2-cell LiPo support with balancing, 9-18V 

charger input 
• Wireless: 802.11bgn, Bluetooth 4.1 and BLE 
• Motor control: 8 6V servo out, 4 DC motor out, 4 

quadrature encoder in 
• Sensors: 9 axis IMU, barometer 
• Connectivity: HighSpeed USB 2.0 client and host 
• User interface: 11 user programmable LEDs, 2 

user programmable buttons 
• Easy connect interfaces for adding additional 

sensors such as: GPS, DSM2 radio, UARTs, SPI, I2C, 
1.8V analog, 3.3V GPIOs 

Software Compatibility 
• Debian, Android, Ubuntu, plus much more 
• ROS, ArduPilot, LabVIEW 
• Cloud9 IDE on Node.js w/ BoneScript lib 

http://www.ti.com/product/am3358
http://www.ti.com/product/am3358
http://www.ti.com/product/am3358
http://www.ti.com/product/am3358


OSD3358 System-in-Package 



 
PocketBeagle 
for Embedded Linux ($25) 

PocketBeagle 

Processor: OSD335x 1GHz ARM® Cortex-A8 
• 512MB DDR3 RAM 
• 4GB 8-bit eMMC on-board flash storage 
• 3D graphics accelerator 
• NEON floating-point accelerator 
• 2x PRU 32-bit microcontrollers 
Connectivity 
• USB 
Software Compatibility 
• Debian, Android, Ubuntu, plus much more 
• ROS, ArduPilot, LabVIEW 
• Cloud9 IDE on Node.js w/ BoneScript lib 

http://www.ti.com/product/am3358
http://www.ti.com/product/am3358
http://www.ti.com/product/am3358
http://www.ti.com/product/am3358


Performance vs Power 



MSP430 is leading ultra-low power processor 

MSP430 

microcontroller 

running off three 

grapes. 

 

It ran for almost two 

weeks before the 

grapes dried out too 

much. 

 

Is this how raisins are 

made? 



TI’s Embedded Processor Portfolio Microcontrollers (MCU) Application (MPU) 

MSP430 C2000 SimpleLink Sitara DSP Keystone 

16-bit/32-bit 32-bit 32-bit 32-bit 16/32-bit 32-bit 

Ultra Low Power & 
Cost 

Real-time 
Wireless and 
Connectivity 

Linux 
Android 

All-around  
DSP 

Massive Performance 

• MSP430  
16-bit RISC 

• MSP432 
32-bit ARM 

• Real-time C28x 
MCU 

• ARM M3+C28 

ARM 

Cortex-M3  

Cortex-M4F 

ARM 

Cortex-A8 

Cortex-A9 

Cortex-15 

DSP 

C5000 
C6000 

• C66 + C66 

• A15 + C66 

• A8 + C64 

• ARM9 + C674 

• Low Pwr Mode 
 250nA (RTC) 
 770nA (LCD) 

• Smart Analog 

• EnergyTrace++ 

• Motor Control 

• Digital Power 

• Precision Timers/PWM 

• M4 w/ WiFi 

• M3 w/ 2.4GHz 

• M3 w/ Sub-1GHz 

• M4 w/ Ethernet 
(MAC+PHY) 

• $5 Linux CPU 

• 3D Graphics 

• PRU 

• Industrial I/O 

• C5000 Low Power 
DSP 

• 32-bit fix/float C6000 
DSP 

• Fix or Float 

• Up to 12 cores 4 A15 + 
8 C66x 

• DSP MMAC’s: 352,000 

Flash: 512K 

FRAM: 256K 

512K 

Flash 

256K to 2M 

Flash 

L1: 32K x 2 

L2: 256K  

L1: 32K x 2 

L2: 256K 

L1: 32K x 2 

L2: 1M + 4M 

25 MHz 300 MHz 120 MHz 1.35 GHz 800 MHz 1.4 GHz 

Rapid Prototype with  
TI LaunchPad Ecosystem 

Get Started with 
BeagleBoards and TI EVMs 



Product Development 
a birds eye view 

Hardware is hard, so you need to have a plan and understand 

the product development cycle 

Concept 

Research 

Evaluation 

Summary from Maker.io 

Design 

Prototyping 

Funding 

Marketing 

Production 

Distribution 

Support 



Want to work for TI? 

78 

• Internships 

• Rotation Programs 

• Full-time positions 

careers.ti.com 

What does TI do? 

What we’ve done  

for over 85 years… 
We connect electronics customers 

to devices and technology that will 

help them build amazing products! 



http://www.google.com/url?sa=i&rct=j&q=&esrc=s&source=images&cd=&cad=rja&uact=8&ved=0ahUKEwjltKe6hPvLAhWlnYMKHUMlA8YQjRwIBw&url=http://www.forbes.com/sites/jimhandy/2011/12/19/whats-it-like-in-a-semiconductor-fab/&psig=AFQjCNEAirBRhhoFqs4PqhidQRLnYtNMdQ&ust=1460067217753094


Nearly Nine Decades of InnovaTIon 

1930s 
Revolutionizes oil 
exploration by 
measuring reflected 
signals  

1940s 
Applies signal  
measurement to  
magnetic anomaly 
detection 

1950s 
Invents the 
integrated circuit 

1960s 
Invents the 
handheld 
calculator 

1980s 
Introduces  single-
chip digital signal 
processor 

1970s 
Applies signal 
processing to 
consumer 
products 

2010s 
Industry’s 
first 300mm 
analog wafer fab 

1990s 
Creates 
first apps processor 
for multi-media cell 
phones 

2000s 
Introduces world’s 
fastest analog-to- 
digital converter and 
lowest-power DC-DC 
converter 
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Digital video 
recorder/server 

Digital 
still cameras 

IP 
phones 

 
Wireless 

infrastructure 
 

Smart phones 

Motor control 

Computing 

Digital TV 

eBike 

Digital audio & radio 

Wireless LANs 

Smart energy 
meters 

Industrial weigh 

scales 

Medical 
Test equipment 

Automotive 

& HEV 

Analog and 

Embedded Processing 

Everyday electronics that use TI technology 

 

 



TI technologies at the heart of every system 

 Signal chain from the real world to the digital realm 



university.ti.com 
The Texas Instruments 
University Program is dedicated 
to supporting engineering 
educators, researchers and 
students worldwide.  
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} { 
Making MADE simple 

With the TI LaunchPad  

Hardware & Software 
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Rapidly Prototype  

TI Solutions with  

Modular Hardware, 

Intuitive Software,  

& Community Support 

The LaunchPad Concept 



This overview shows why TI LaunchPad™ is the highest 
value microcontroller development tool on the market 

Modular & Affordable 

Hardware 

Intuitive & Flexible 

Software 

Accessible & Engaged 

Community Support 
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LaunchPad is TI’s Common Denominator 

95 

TI Wireless: Sub-1GHz, NFC/RFID, Wi-Fi, ZigBee, BLE, Bluetooth 

Analog, sensors, displays & more from TI, 3rd parties & Maker 

community 

Modular hardware enables developers to explore new ideas quickly 

MSP430 
(Ultra-Low Power) 

MSP432 / TM4C 
(ARM Cortex M4F) 

C2000 
(Real-time Control) 

 

Hercules 
(Safety) 

LaunchPads featuring TI MCUs & BoosterPack interface 

SimpleLink 
(MCU + Connectivity) 
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The LaunchPad Ecosystem 
Everything you need to start microcontroller development 

Hardware + Software + Community 

Over 20 types of LaunchPads for 

different application needs! 



The LaunchPad Ecosystem 

Full specs at www.ti.com/launchpad 

General & 

Special 

Purpose 

MCUs  
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The FRAM Advantage: At a Glance 

  Write More 
Collect more data over time with 100x faster writes than Flash  

Extend product life and ditch the EEPROM with infinite endurance  

Decrease Power 
Extend battery life with 250x lower energy writes vs Flash 

Minimize wireless system power by shortening memory update times 

 

Unified Memory 
Simple to use with unmatched flexibility 

Migration guides, code examples and application notes available! 

www.ti.com/fram 
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The LaunchPad Ecosystem 
Everything you need to start microcontroller development 

Hardware + Software + Community 

Many orderable BoosterPacks and 

open source designs available! 
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The LaunchPad Ecosystem 
Everything you need to start microcontroller development 

Hardware + Software + Community 
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Sidekick Basic Kit for TI LaunchPad™ 
Part List 

1x Breadboard 

1x Breadboard Adapter BoosterPack 

5x Green LED 

5x Red LED 

1x RGB Common Anode LED 

10x Ceramic Capacitor 10nF 

10x Ceramic Capacitor 100nF 

5x Aluminum Capacitor 100uF 

10x Resistor 330 ohm 

10x Resistor 1K ohm 

10x Resistor 10K ohm 

1x Tilt Switch 

1x Thermistor 

1x Photoresistor (photocell) 

1x Diode 

1x Piezo Buzzer 

 

 Learning Over 100+ electronic components to build basic and complex circuits 
Compatibility Useful with any TI LaunchPad or other digital / analog development kit 
Completeness All the popular accessories for beginners to develop with microcontrollers 

5x Button 

5x Switch 

2x Potentiometer with knob 

1x Small DC Motor 

1x 7 Segment Single Digit Display 

1x 8-bit Shift Register (SN74HC595N) 

2x NPN Transistor (2N2222) 

1x Analog Temperature Sensor 

(LM19CIZ/NOPB) 

5x Jumper Wire Long 

20x Jumper Wire Short 

1x Sidekick Manual 

 

Manufactured by Seeedstudio 
 

Learn more @ www.energia.nu/sidekick   

http://www.energia.nu/sidekick
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Grove Starter Kit for TI LaunchPad™ 
Part List 

1x Grove Base BoosterPack 

1x Grove Buzzer (Digital) 

1x Grove Relay (Digital) 

1x Grove 4-Digit-Display (Digital) 

1x Grove Ultrasonic Range Sensor (Digital) 

1x Grove PIR Motion Sensor (Digital) 

1x Grove Light Sensor (Analog) 

1x Grove Sound Sensor (Analog) 

1x Grove Moisture Sensor (Analog) 

1x Grove Temperature Humidity Sensor (Analog) 

1x Grove Rotary Angle Sensor (Analog) 

Grove Cables 

Starter Guide Manual 

 

 

Learning 10 different grove modules to build basic and complex systems  
Compatibility Useful with any TI LaunchPad or other digital / analog development kit 
Completeness All the popular accessories for beginners to develop with microcontrollers 

Manufactured by Seeedstudio 
 

Learn more @ www.energia.nu/grovekit  

http://www.energia.nu/grovekit
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Click BoosterPack 2 

Click BoosterPack 2 has two mikroBUS sockets onboard, for 
simple and easy integration of MikroElektronika click boards 
with a TI LaunchPad™. 
 
Add new functionality to your LaunchPad within minutes. 
More than 250 click boards available from audio and voice 
to power management and wireless connectivity clicks.   
 
All MikroElektronika compilers come with code examples, so 
you’ll have a great base to start with. 
 

Learning Click boards to build basic and complex systems  
Compatibility Useful with any TI LaunchPad or other digital / analog development kit 
Completeness All the popular accessories for beginners to develop with microcontrollers 

Manufactured by MikroElektronika 
 

Learn more @ www.energia.nu/click  

https://shop.mikroe.com/click
http://www.energia.nu/grovekit


145 For FREE! 

CODE! 



LaunchPad Software Tools - providing multiple points of entry 

Energia 
Light-weight, Community-driven, 

Wiring-based IDE for quick evaluation 

• Intuitive coding environment 

• Simplified interface 

• Highly-abstracted API framework 

• Open Source & Community-driven 

CCS & Pro Tools 
Fully-capable dev environments 

from TI & third parties 

• Full debug capability & more 

• Import Energia projects 

• Access to third party 

compilers,  features, and apps 

Rapid Prototyping Advanced 

CCS Cloud  
Browser-based code editor and 

Resource Explorer 

• Cross Platform 

• Fast start & no installation 

• Use Energia, TI-RTOS & more 

• Resource Explorer integration 

Evaluation 

Intuitive & flexible software development paths speed up 
firmware creation for rapid prototyping 



Energia Abstraction 
Fly high above the bits & bytes 
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Boils it down to      line of code 1 { } 
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Energia Import in CCSv6+ and CCS Cloud 
• Import an Energia sketch into Code Composer Studio v6 or v7 & pick up right where you left off. 

• CCS introduces full debug capability & other professional features to further optimize your design. 

• Modularize your code & leverage Energia APIs & libraries within CCS 

• Enable “hybrid” projects that leverage low-level C, assembly & even abstracted Energia APIs 

enabling a developer maximum flexibility during code development. 



152 

Code Composer Studio Cloud 

• Browser based code editing tool  

to get your started quickly 

• Access Resource Explorer to get  

the latest code examples, design  

files, and more. 

• Cross Platform and allows you  

to upload firmware using TI  

Cloud Agent + Browser Extension 

• Extended Debugging capability 

http://dev.ti.com  
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Resource Explorer 

• Access Resource Explorer to get  

the latest code examples, design  

files, and more. 

• Support for TI-RTOS, FreeRTOS, 

and non-RTOS based code 

examples 

• Materials for all TI processors 

searchable by part number and 

EVM 

http://dev.ti.com  
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GUI Composer 

http://dev.ti.com  

• Create an interface to your 

application using user interface 

tool from TI 

• Make use of streaming data, 

graphing tools, and widgets 

• Share the GUI through the web or 

export to a local PC application 
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BoosterPack Checker 

http://dev.ti.com  

• Check compatibility with 

different LaunchPad and 

BoosterPack combinations 
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Code Composer Studio 7 
• Eclipse-based IDE for professional 

firmware developers that supports  

all TI processors 

• CCS App Center allows you to stay 

current with the latest plugins and 

updates 

• Use tools such as Energy Trace, 

GRACE, and more to optimize your 

workflow and application 

• Resource Explorer exposes thousands 

of code examples  

and technical materials 

 

Download CCS Desktop at ti.com/ccstudio 



• Many free and open source options 

available today with TI RTOS and 

FreeRTOS recommended for TI devices 
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TI-RTOS and FreeRTOS 
• The use of Real-Time Operating 

Systems (RTOS) is getting more 

common for IoT firmware deployment 

• A simple operating system can 

schedule tasks and do a variety of 

functions  

• RTOS helps with maximizing power 

efficiency, implementing security, 

managing wireless communication, 

and other complex functions  

• Improves software quality and 

portability 

 

Download TI-RTOS at ti.com/tool/ti-rtos 



MSP Software Development 
Pick a Coding Style…             Choose a Tool… 

Energia IDE 

CCS Desktop 

CCS Cloud 

/ RTOS 



www.43oh.com  e2e.ti.com  

Accessible & engaged community support gives new and 
experienced developers information to solve issues quickly 

www.hackster.io/ti-launchpad  ti.com/lyd 

http://www.43oh.com/
http://e2e.ti.com/
http://www.hackster.io/ti-launchpad
http://www.hackster.io/ti-launchpad
http://www.hackster.io/ti-launchpad
http://www.ti.com/lyd
http://www.ti.com/lyd


• www.43oh.com 

• ~20,000 active members 

• ~60 forum users online at any given time! 

• Active & friendly online community & blog for the 

LaunchPad ecosystem! 

• Home to much of the Energia community 

The Community 
Get support from TI & the online community! 

• http://e2e.ti.com   

• Supported 24/7 by TI engineers! 

• Over 1 million Q&As available on-demand 

• Get support on TI’s complete portfolio from 

microcontrollers to analog to connectivity 

http://www.43oh.com/
http://e2e.ti.com/


                             - Share your electronics projects! 

www.hackster.io/ti-launchpad 

www.hackster.io/texasinstruments  
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http://www.hackster.io/ti-launchpad
http://www.hackster.io/ti-launchpad
http://www.hackster.io/ti-launchpad
http://www.hackster.io/texasinstruments
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Where to go next: www.ti.com/launchpad 
TI’s official LaunchPad portal 

Get specs, order hardware, find software tools, and 
download datasheets and design files 

Sign up for a 

myTI account! 

http://www.ti.com/launchpad


} { 
Making MADE simple 

With the TI LaunchPad  

TI LaunchPad™ provides an ecosystem of hardware and 
software products, and community online resources that 
provides incredible value for rapid prototyping 

Questions? 

www.ti.com/launchpad 



Lab 3 Wi-Fi IoT with Temboo and Twitter 

We will break here to get to the heart of the lab portion! 

• Step 1: Navigate to the lab details or refer to handout 

• Step 2: Create an account on www.temboo.com  

• Step 3: Follow the lab details, no rude twitter shenanigans please 

• Step 4: Raise your hand if you need assistance 

Lab: https://goo.gl/VbymuW 
SSID: TEXINS3 

PASS: launchpad 
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Wi-Fi Connection for your LaunchPad, 

not your laptop, thanks! 

http://www.temboo.com/


Lab 4 GUI Composer 

We will break here to get to the bonus lab portion! 

• Step 1: Navigate to the lab details or refer to handout 

• Step 2: Follow the lab details 

• Step 3: Raise your hand if you need assistance 

 

Lab: https://goo.gl/VbymuW 
SSID: TEXINS3 

PASS: launchpad 
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Wi-Fi Connection for your LaunchPad, 

not your laptop, thanks! 



Lab 5 More Wi-Fi IoT with Temboo 

We will break here to get to the bonus lab portion! 

• Step 1: Navigate to the lab details or refer to handout 

• Step 2: Follow the lab details 

• Step 3: Raise your hand if you need assistance 
 

Lab: https://goo.gl/VbymuW 
SSID: TEXINS3 

PASS: launchpad 
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Wi-Fi Connection for your 

LaunchPad, not your laptop, thanks! 

SSID: TEXINS3 

PASS: launchpad 
Local Wi-Fi Connection 

for your computer 



Thank you! 
 

www.ti.com/launchpad 
 
 


